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3. PRODUCT REGISTRATION: Completing the Product Registration card enables you to take advantage of 
Customer Support Services. 
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Chapter One 
Introduction 

Welcome! This exciting new program was designed exclusively for the Apple ][ GS 

computer and is simple enough so that anyone can learn how to use it. 

The program is actually the result of a very special technical breakthrough. It is a unique 

Word Processing and Graphics System package contained in a single program. It can be 

boldly stated that there is no other program like it! 

Much of this is due to the new, incredible Apple ][ GS computer which is quite ahead of 

its time. Most other computers can only display TEXT (letters and numbers) on the screen 

and "force" you into heavy use of the keyboard. However, the Apphl ][ GS is capable of 

displaying COLORED PICTURES that represent various functions of the program which 

YOU select with the aid of a "mouse" that is simply maneuvered about your desktop. 

Your mind "thinks" in terms of PICTURES, right? Therefore, the Apple ][ GS is 

naturally a true personal computer! 

Of course, no computer means a thing without a good program to tell it what to do. You 

now have such a program! We call this GraphicWriter: a combination of typing and 

drawing tools. It is YOURS to use, yours to enjoy. 

May your computering never be the same ... 



1.1 A Word from the Author 

The author of your program, Gary Crandall, has many years of experience writing 

programs for computers. He has become quite an expert programmer with all Apple 

computers. He enjoys talking with his many friends around the country in order to design 

and write the best and most useful software possible. He would love to hear from you, too! 

Feel free to write to him (c/o DataPak) and let him know what you think about your new 

program. 

We asked Mr. Crandall to write a special message for the users of this program. Feeling 

free to say anything he wanted, this is what he chose to tell you: 

"I have two very important rules to offer you while learning all about 
GraphicWriter: 

(1) Know an about your Apple ][ GS and how to use it, and 
(2) Do nol confuse GraphicWriter with other Apple n software. 

"I have discovered, through my own personal contact with users of 
GraphicWrRtel', thaI Ihe single mosl confusion and trouble is the failure to 
grasp its simplicity". 

"These same people who were confused required little or no training to 
take a fel1 marker and slar! drawing on a piece of paper. They had very little 
trouble drawing lines or even 'pasling' pictures on some kind of art layout. 

"And yet what I just described is about as complicated as GraphicWriler 
ever has '10 get! So I have found thai un~learning some other bizarre computer 
ideas, concepts or practices was usually the solution to most people's 
"trouble" with GI·aphicWriler. 

"But just because it's simple doesn't mean ii's not powerful. There isn't one 
single piece of software that even comes close to GraphicWriter, regardless of 
Iheir fantastic claims for the Apple ][ GS. I happen to know this, since 
GraphicWriler was designed specifically to fill a gaping hole in the market 
place for versatile, ~ software. 

"So remember the two rules: Learn about your Apple ][ GS, and don't 
confuse GraphicWriter with other Apple ][ programs and you can't go 
wrong!" 

Gary Crandall 
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1.2 About the Program 

GraphicWriter is easy and fun to use! Simply turn on the computer and 

Type Letters or Documents with the WORD PROCESSOR: 

Draw right on the screen to create special ARTWORK: 

Paint with COLORS using the artist's PALETTE: 

Combine TEXT AND GRAPHICS for real desktop publishing: 

PRINTING is as easy as using a copier machine: 

And out comes your final printed DOCUMENT: 

Then, open the DOOR to other Offices: 

II] 
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1.3 Getting Started 

~ 
Booting-Up 

The very first thing you do is: 

1) EJECT and REMOVE any disks from the disk drive that you might be 

currently using and turn off your Apple )[ GS. 

2) Insert the GraphicWriter program master diskette into the external disk drive. 

If you have a second disk drive, insert a data-only disk as desired. 

3) Ensure the write-protect tab is shut. This allows writing to the disk. 

4) Turn the computer on. In a moment or two you will arrive inside 

GraphicWriter and see the following screen: 

GraphicWriter's main screen. Please refer to this picture as you study. 



Clicking the Mouse 
Move the pointer to the bottom left corner of the screen so that it is directly on the 

RECTANG LE, as shown below, and PRESS THE MOUSE BUTTON. This is called 

"CliCKING THE MOUSE": 

Notice how the RECTANGLE becomes HIGHLIGHTED (black). This means it has 

been SELECTED (which is how we choose which TOOL we wish to use). Now, move the 

pointer up to the middle of the screen. The ARROW will change to a CROSS. This will aid 

us during our drawings. 

Here's how we draw a simple rectangle: CLICK the mouse button, but this time KEEP 

THE BUTTON HELD DOWN and MOVE THE MOUSE DOWNWARD, and to the right. 

You will see that a RECTANGLE is formed as the pointer moves. Keep moving the pointer 

in various directions. When you release the mouse button, a final RECTANGLE will remain 

on the screen: 

This activity is called "DRAGGING". Go ahead and experiment with some of the other 

TOOLS at the bottom of the screen (The "A .. ", for "ASCII" characters, is used for typing). 

Menus 
At the top of the screen are what we call MENUS. These allow you to choose a variety 

of features or functions that tell the program what you want to do. Move the pOinter up to the 

top left corner of the screen, and PRESS AND HOLD DOWN the mouse button directly 

on the Apple ~ character: 

Notice how the MENU "drops down" and comes to view. Slowly DRAG the pointer 

downward (keeping the button depressed) across the "items" of the MENU as shown above. 
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1.4 For Beginners Only 

All advanced wizards may skip this section and go on ahead. You beginners probably 

don't mind admitting that you want some extra help before plunging into the program. Well, 

we don't want you to feel "left out" or "stupid". We all started at the very beginning some time. 

There's nothing embarrassing about simply NOT KNOWING what to do. For these 

reasons, we have devoted this section just to beginners. 

Of course, the BEST learning tool is your Apple ][ GS User's Manual that came with 

your new computer. Please look it over and carefully study it first. Doing so will give you 

many extra benefits than you would normally get if you were to just read this manual alone. 

There is really only a HANDFUL of things you need to know about the Apple ][ GS in 

order to do well with GraphicWriter. Please refer to the previous picture of the main 

screen (1.3 Getting Started) as you try out the following examples: 

The Pointer 

The first thing to learn about is called the POINTER: 

When you move the MOUSE on your table, this ARROW will likewise change its 

position on the screen. Go ahead and try this right now. 

The POINTER is used, as you can guess, to "point" to various images on the computer 

screen in order to tell the program WHAT you would like to do. 
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As the POINTER passes over an item, that item becomes HIGHLIGHTED (black). 

Upon releasing the mouse button, that ITEM FUNCTION Will BEGIN, that is, 

GraphicWriter will then perform whatever task the MENU ITEM TELLS iT TO DO. 

When the arrow is over "About GraphicWriter", let go of the mouse button. This will 

present a little window on the screen telling you a few things about the program. When 

finished, click the mouse button and the little window will disappear. 

It is safe for you to "pull down" the other MENUS to see what is on them, but be careful 

NOT to select anything else (don't let go of the mouse button). We shall learn all about them 

later on. 

Closing the Window 
In order to prepare for the next chapter you will have to put away the current window 

you've been playing with. This is done by moving the pOinter to the little square CLOSE 

BOX and clicking in it, as shown below: 

Be sure the pointer remains within the little square when you release the mouse button. 

Another window will then appear asking you if you want to Save the Changes (your 

drawing tests). At this time click on the "No" button. The screen will be cleared and you will 

be all set for the next chapter. 

So, you see this isn't going to be very hard at all, right? You've learned how to MOVE 

the pOinter, how to CLICK on something to select it, how to DRAG the mouse in order to 

DRAW a simple rectangle, as well as how to choose something from the MENUS and how 

to CLOSE a window. 

Hey, you're already a prol 
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Chapter Two 

Word Processing 

Words on the Apple ][ GS screen can be formed in many different shapes and sizes. 

GraphicWriter has a built-in Word Processor that allows you to "process" these words and 

change their appearance. Word Processing also involves what is known as "Cut & Paste". 

This is similar to the way a layout artist takes a document, cuts out various words or 

paragraphs with a pair of scissors, then pastes them onto a "workboard" to create a final 

master template that will be used for printing. 

The Apple ][ GS is ideal for creating and editing documents right on the screen. Using 

GraphicWriter is as easy as using a typewriter, but GraphicWriter lets you easily correct 

any typing "mistakes" you might make by allowing you to quickly take out words or move 

them around to different places within your document with the aid of the mouse. 

GraphicWriter also offers you various typefaces which are called FONTS. These are 

used for typing characters of different sizes, shapes and styles. Included are your general 

Word Processing features such as left and right margins, tab settings, aligning text on the 

page in various justifications, not to mention the capability of typing in COLORS. 

Even though it is fun to play with the pretty fonts and styles, you can also get down to 

some serious business creating professional documents or reports, and print them just as 

easily. 
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2.1 The Word Processor 

In order to get the most out of the WORD PROCESSOR, it is very important that you 

fully understand how it operates and what it can do for you. It is quite true that an entire book 

could be written on the subject of Word Processing, but here you will find we have broken 

down the steps so that you CAN understand how it all works. 

Creating a New Document 
To create a new document simply start up GraphicWriter and you're ready to begin 

typing. Or, if you performed the mouse "tests" in the "Beginners Only" section, then 

CLOSE the window (without saving the changes) and go up to the File menu and select 

"INew Document": 

This brings up a new, "Untitled" window, just the same as if you booted-up from scratch. 

A blinking cursor awaits your keystrokes: 

I 
"'- the CURSOR 

The word "cursor" literally means "a pointer" or "point of insertion". It represents the 

position of where the next character will appear on the document when you start typing. 

Begin typing "This is a test of the word processor.", as shown below: 

The blinking cursor advances along as you type indicating the eventual position of the 

next typed character. 
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As you are typing, the POINTER changes from an arrow to what we call an "I-Beam": 

I 
By moving the mouse you can select where you would [ike the blinking cursor to be 

positioned and inserted within your document. You can maneuver this I-Beam POINTER 

between characters, click the mouse button and a new position of the blinking cursor will be 

obtained. From there you can begin typing in new characters, or BACKSPAC[h[G out 

characters on the [eft. Try this out on your "lest" sentence. 

Highlighting Text 
The KEY to using the Word Processor centers around !iIGHUGHTit~G TEXT. By 

"HIGHLIGHTING" we really mean "SELECTING". Thus, to process words, you need to 

tell GraphicWriier which WORDS you want to PROCESS and HOW you w'Ju[d [ike this 

done. 

Now, position the pointer just to the right of the letter "d" in "word", as shown be[uN: 

Click and hold down the mouse button while DR.AGGING the POiNTiER to the [eft 

across "word" so that it becomes high[igilted (b[ackened): 

(Of course, you could have started to the [eft of "word" and dragged to the right). 
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Processing Highlighted Text 
When some text has been highlighted (selected), you can perform various operations on 

it. Let's select "Bold" from the Style menu: 

oP 

01 

"Word" will then appear in BOLDFACE. You can see this, if you'd like, by clicking 

somewhere else on the window. Note that whenever you click the mouse, any highlighting 

will be eliminated, so you'll have to RE-HIGHLIGHT the words to continue our example. 

You can also choose a different fONT from the Font menu, or a different SiZE from the 

Style menu, or use them in COMBINATION. Just the text that is highlighted will be 

changed. As your document grows, you can even highlight multiple paragraphs (by 

dragging across them) and "operate" on the entire sum of highlighted text. 

Ways Highlight Text 
There are a few other ways to highlight text besides dragging the pointer over it: 

DOUBLE-CLICKING ON A WORD (2 quick presses of the mouse button) will highlight 

that particular word. It doesn't matter which character of the word the POINTER is on when 

you DOUBLE-CLICK, the WHOLE WORD will become highlighted (selected) allowing 

you to choose a new font or style (or color) just for this word. 

SHIFT-CLICK (holding down the SHIFT key while clicking) will highlight ALL OF 

THE TEXT BETWEEN the current position of the "blinking" edit cursor and the position of 

the click. For example, suppose the "blinking" cursor is located at the BEGINNING of a 

sentence. If you were to position the i-Beam pointer at the END of the sentence and do a 

SHiFT-CLICK, then ALL OF THE WORDS OF THE SENTENCE will become 

highlighted. In this way, multiple paragraphs, or even an ENTIRE DOCUMENT (through 

the use of "scrolling", as covered later) can be highlighted and operated upon. 
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The Edit Menu 
The Edit menu offers some "tools" that you can use while working with a document. It will 

allow you to take characters or words in your document and Cut them out, Copy them, or 

Paste the Copy back into your document. These are used so often that they have keystroke 

equivalents for them: OPEN APPLE-X to Cut, OPEN APPLE-C to Copy and OPEN 

APPLE-V to Paste. Notice that these 3 keys are altogether at the left side of the keyboard. 

Removing Text 
It is very easy to REMOVE text from a document. All you have to do is highlight the 

desired text, then press the BACKSPACE key. Another way is to highlight the text and just 

start typing. The first keystroke will eliminate the highlighted text before inserting the newly 

typed characters. The text will be removed permanently. (However, if "Undo" is active on the 

Edit menu, you may select it to cancel the last activity). 

Cutting Text 
A more sophisticated way to remove the text is to highlight the desired section and then 

Cut it from the document. Let's try this out. Ensure that "word" is once again highlighted and 

then select "Cut" from the Edit menu, or press OPEN APPLE-X: 

You will see that, indeed, "word" has been removed from the sentence: 
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Clipboard 
Wrlen you Cllt out some text, it isn't gone forever. It goes into what we call the 

Clipboard. This "stores" the text in memory for future use (replacing whatever text was 

there before it). You can always REVIEW the contents of the Clipboard by selecting "Show 

Clipboard" from the Edit menu. The Clipboard window can be moved about the screen 

by dragging the window by its top "black" part. You can put this Clipboard window away by 

clicking in its CLOSE BOX or by selecting "Hide CUpboard" from the Edit menu when 

presented (or by clicking directly on the title of your document). 

Text 
Another function you can employ while text is highlighted is to make a Copy of it. By 

selecting "Copy" from the Edit menu, the highlighted text will also be moved into the 

Ciipboa~d, but this time the highlighted text will NOT be taken away from the document. 

Therefore, the Qll.]y difference between Cut and Copy is that Cut removes the text from 

the body of the document. They both will "save" the text on the Clipboard. Using the 

BACKSPACE key or just typing when text is highlighted will, of course, remove the text 

WITHOUT placing it onto the Clipboard. 

Text 
When the Clipboard has some text in it, either by Cut or Copy, you can then take its 

COIHEi'ITS, and Paste it anywhere back INTO your document. To do this, position the 

I~Beam pointer and click the mouse button at the desired STARTING location so that the 

edit cursor is "blinking" there. The pasted text will be INSERTED into the document 

beginning at this point upon selecting "Paste" from the Edit menu. You might notice that the 

new text is placed into the document while retaining its original font, size and style. 

It should also be pointed out that if any text is highlighted when selecting "Paste", then 

the highlighted text will first be eliminated before the new text is inserted. This is exactly like 

removing the highlighted text by first hitting the BACKSPACE key just prior to Pasting. 
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2.3 Ruler Settings 
10' 1 1 I 1 I 1 111 1 1 I 1 1 1 121 I I I 1 I I 131 I I I I 1 I Iq 1 I 
r I , 

The RULER is used as a "measuring stick". Although it is displayed across the top of 

your document, it is only IMAGINARY in that it will NOT appear when you print your final 

document. It simply serves as a "guide" for FORMATTING your documents, which we will 

cover very shortly. By selecting various SETTINGS, the text can be "molded" or confined 

within certain boundaries dictated by left and right margins, or it can be forced into certain 

positions on a line by using what we call TAB MARKS. 

Rulers vs. Paragraphs 
A Ruler is always related to a specific PARAGRAPH. There is only one Ruler per 

paragraph and each paragraph will contain a Ruler. A paragraph is simply defined as a 

body of words or sentences that ENDS with a carriage return. When you are typing, as soon 

as you press the RETURN key, the paragraph ends and a new one begins. A new Ruler is 

automatically created for this new paragraph and will conveniently be an exact "copy" of the 

same Ruler from the previous paragraph just finished. 

Since each paragraph has a Ruler, you can actually have SEPARATE Ruler settings for 

your paragraphs. A Ruler is set for a particular paragraph WITHOUT effecting any other 

paragraphs. The rule to remember is: 

THE RULER YOU SEE ON THE SCREEN WILL ALWAYS BE RELATED TO 

THE PARAGRAPH THE "BLINKING" CURSOR is LOCATED IN AT THE TIME. 

Formatting a Document 
There are 4 possible ALIGNMENTS: Left; Right; Centered and Fully Justified, as found 

under the Format menu. Select the type of justification and begin typing. The new text 

entered will then appear in the chosen ALIGNMENT. Or, for previously typed text, you can 

highlight the text (actually, any characters in the paragraph) and then select the justification. 

Multiple paragraphs can be highlighted, in the usual manner, and then justified all at once. 
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Then we will drag this RIGHT MARGIN MARK towards the left to the 3 inch line. Upon 

releasing the mouse buiton, the text will CONFORM to the boundaries of our new settings: 

Word Wrap 
You will notice in the above example that "processor." moved down to the next line. 

This is because it would have extended PAST THE 3 INCH RIGHT MARGIN MARK. Let's 

look at this more closely. We will place the pointer just to trle right of "processor." and 

BACKSPACE the characters out. The "blinking" cursor is now right after the word "the": 

When we begin re-typing "processor", we will gelto the "p" and run out of room on that 

line: 

As soon as we type the rest of "processor", the whole word will NOT FIT on the line, so 

it must "wrap" down to the next line. 

The reverse is also true. If we start BACKSPACING out "processor", then when we get 

to the "p", which will once again FIT on the top line, it will "reverse wrap" back up to that line. 

Needless to say, we could have MADE the word fit on the top line by simply dragging the 

RIGHT MARGIN from the 3 inch MARK out to the 4 inch MARK. 

Remember, these MARGINS pertain ONLY to the paragraph you are in at the time, and 

you can have different MARGIN settings for each paragraph throughout your document. 
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Paragraph Indentation 
The INDENTATION MARK, at the LEFT SIDE of the Ruler, signifies where the FIRST 

WORD of a paragraph will be positioned. As you type, and the sentence "wraps", a new line 

will begin at the LEFT MARGIN MARK: 

PARAGRAPH 
I NIIENTATI ON 
MARK 

The INDENTATION MARK can be moved by placing the pointer on it and dragging it to a 

new setti ng: 

In this case the paragraph begins at the INDENTATION MARK and "wraps" to the next 

line (continuing on from the LEFT MARGIN). The LEFT MARGIN can likewise be set inward 

from the le11 side to align the text of the paragraph much more attractively. BOTH MARGINS 

can be used in combination with the INDENTATION MARK. 

Single & Double Une Spacing 
The body of text 01 a document can also be formatted with Single or Double line 

Spacing. Selecting "Double Spacing" from the Format menu will insert a BLANK 

LINE between every line. Re-selecting "Single Spacing" will remove the added lines. 

Note that the chosen Spacing will affect the ENTIRE document. 

Tab Markers 
A TAB MARK is used to designate WHERE you want the cursor to go when you hit the 

TAB key. These MARKERS, when placed on the Ruler, will "force" the text to be positioned 

on the screen. When a TAB MARK setting is changed, the text will ADJUST to specific 

locations, as called for by the MARKS. 
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There are 3 types of TABS: Left; Center and Decimal, as found under the Format 

menu. They can be selected using OPEN APPLE-1, 2 or 3, respectively. They can b!3 used 

individually or in COMBINATION. You may select up to a total of 6 for each paragraph. 

Left Tabs 
When you select "Set Left Tab", a new mark will appear on the Ruler. To change this 

MARK, position the pointer on it and DRAG it to a new location. This will act upon the text in 

that paragraph only. 

In the picture below, we have positioned into place a Left Tab MARK at the 1 inch line 

on the Ruler. Note the current position of the "blinking" edit cursor (just under the 

INDENTATION MARK): 

When a Left Tab has been positioned, and you press the TAB key, the cursor will 

ADVANCE to it: 

Any typing you now do will begin AT THIS TAB MARK. 

You can also place multiple Left Tabs on the Ruler. For example, if a second Left Tab 

is placed at the 3 inch MARK, the edit cursor will move to the 3 inch MARK when you hit the 

TAB key again. In this way you can control where the edit cursor will move, but more 

importantly, you can begin to dictate where the typing will occur on the document window. 

This process is very important when it comes to designing the desired document. 
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Center Tabs 

A Center Tab can be placed in a similar manner and causes the text, after pressing the 

TAB key, to be CENTERED as you begin typing: 

Note that the mid-point of the sentence is directly below the Center Tab (on the Ruler). 

The position of a sentence on a line will therefore be determined by its LENGTH when 

centered beneath this MARK. 

Decimal Tabs 
In the next example, we selected "Decimal Tab" and positioned it at the 2.5 inch MARK. 

Again, pressing TAB will advance the edit cursor to it: 

123,456 
j 2346.71190 

Notice that this MARK has a "dot" to its right. This is how you can tell the differe.nce 

between a Decimal Tab and the other TABS. The interesting thing about a Decimal Tab 

is that when typing begins, any numerical values will have their DECIMAL POINTS 

aligned vertically, as shown above. This sets up the possibility of creating a professional 

report which will show a LIST OF AMOUNTS, such as PRICES or DOLLAR TOTALS and so 

forth. 

Removing Tabs 
A TAB MARK can be removed at any time by simply dragging it off the Ruler and letting 

go of the mouse button. 
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2.4 Paging 

Page Numbers 
You can type out a very long document without stopping (although you should always 

Save your document from time to time for "insurance" against unforseen disasters). The 

Word Processor uses what we call VIRTUAL PAGE which means it acts as if you had an 

infinitely long piece of paper fed "forever" through the program's "typewriter". 

As you type, the document will be separated into NUMBERED PAGES. These PAGES 

will simply be the divisions of what the document will look like when printed. Each PAGE 

therefore represents ONE PIECE OF PAPER. The Page Number that you are currently 

typing in will be shown at the lower left corner of the window: 

IPage: 

Scroll Bars 
On the right side and along the bottom of the document window are what we call 

SCROLL BARS. These allow you to move through a large document rather swiftly, in order 

to pin-point the exact Page you would like to edit. 

Clicking on the DOWN ARROW moves the contents of the window upward a UNE or 

two at a time: 

ill the mornillg 
in the mornillg 
autumn leaves 

Or clicking on the UP ARROW will move the contents downward on the screen (as you 

would essentially be heading towards the very top of the document). 

Holding down the mouse button on an ARROW will act like "consecutive clicks" and 

continue moving the contents. This, then, is called SCROLLING since the lines of text will 

be seen to "scroll" up or down on your document window. 

21 



You can also SCROLL RIGHT or LEFT by using the bottom SCROLL BAR which 

works in a similar fashion. However, you will really only need to do this when your RIGHT 

MARGIN is set beyond 8 inches. Note that you can go out to the right up to 15 inches, but 

you can ONLY print such a document on the Wide ImageWriter. 

The Thumb 
The way to move through the document a few "screens" at a time is by dragging the 

white rectangle called the THUMB: 

You might have noticed that when you clicked on the ARROWS, this THUMB also 

moved. The TH U M B rectangle is positioned along the SCROLL BAR in the exact 

PROPORTION of the contents you currently see with respect to the ENTiRE 

DOCUMENT. Thus, if the THUMB is at the top of the SCROLL BAR, then you will know 

that you are at the very beginning of your document. If you drag it to the middle 6f the 

SCROll BAR, then release the mouse button, you'll be at the halfway point of your 

document, and so forth. Clicking on the actual gray part of the SCROll BAR will also 

advance the contents a few "screens" at a time. You can reverse the direction of the "scroll" 

by clicking on the OTHER SIDE of the THUMB (when the gray appears on that side). 

As you drag the THUMB, the Page Number of its position will also be shown (in its 

usual place at the bottom left corner). Therefore, you can drag the THUMB while examining 

the displayed Page Number in order to "pinpoint" the exact page you'd like to go to. Note 

that the actual SIZE of the white rectangle represents how much memory remains for your 

document. As your document grows in length, the THUMB rectangle will shrink. 
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Page Breaks 
As you are typing a document, you will come to the end of a page (as it would be printed 

on paper). At this time a line will be displayed across the screen indicating the fact. This is 

known as a PAGE BREAK. What this means is that during printing, the paper will be fed 

through the printer to the next sheet. You can force this to happen at any time by positioning 

the "blinking" cursor at the desired place and then selecting "Insert Page Break" from the 

Page menu. During printing, a form feed will occur exactly at this point, with subsequent 

printing continuing on the next sheet of paper. 

You can always tell where a Page Break exists by the fact that the screen will be 

"empty" between the Break and the bottom 01 that Page. Of course, you aren't allowed to 

type within this area. Upon reaching such a Break during typing, the cursor will "hop" down 

to the next Page. However, an inserted Page Break can be removed by positioning the 

cursor anywhere within the LAST PARAGRAPH 01 the Page and selecting "Remove 

Page Break" from the Page menu thereby removing the Break "area" from the document. 

Headers and Footers 
A HEADER, or a FOOTER, is simply a line, or a few lines, that you would like to have 

printed at the top or bottom of every page. To create a HEADER or FOOTER simply type 

the text and then HIGHLIGHT it. Immediately select "Copy as Header" or "Copy as 

Footer" from the Page menu. The text will be saved (replacing any previous ones) and will 

appear during printing. You can examine a HEADER or FOOTER by selecting "Show 

Header" or "Show Footer" from the Page menu in which case they will appear on the 

screen. Common usages for HEADERS or FOOTERS include your company's name and 

address (or logos and other Graphics drawings as covered later) which will then become 

your special letterhead stationery: 

Acme Plrintiog Co. 
123 Ha;" St. 

Los ..... g"les. C'" 90028 

,---------------:fast J) qua tHy service ___ '" 
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Show Full Page 
Since an entire 8 1/2 by 11 page cannot "fit" onto the screen all at once, there is an item 

under the Page menu called "Show Full Page". By selecting this you will be shown a 

miniature representation of the current page of your document: 

OK ~ 

This function is often used to see what your page will look like prior to printing, especially 

when it contains numerous graphics drawings or complex layouts. By examining the full 

Page from time to time, you can then create your document with full assurance it will be 

taking the form you had originally planned. 

Click the "OK" button when done viewing the Full Page window and you will be 

returned back to the normal editing mode. 

After you have studied the next chapter concerning Graphics drawings, we will learn 

more about Show Full Page in the Page Making chapter (5.4 layouts). 
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Chapter Three 

Documents 

You can elect to create anything from simple notes and letters to fancy business reports, 

The number of documents you create is only limited by disk space, and you can always 

create a separate disk to be used as data only. 

Simple notes and memos are the easiest of all to make. Simply type and save, On the 

other hand, a business letter would probably need to make use of various tab settings and 

justifications. A report utilizing columns of numbers will look very nice with decimal tabs, and 

so forth. 

The more demanding your needs, the more complex the document will become and in 

this case it will be important to know the various functions of the word processor RULER (as 

explained in the previous section), But once you've got the hang of it you can jump right in 

and type in colors or add graphics drawings to your documents! 
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3.1 Creating Documents 

A brand new document is always called "Untitled" until it is saved. You simply run 

GraphicWriter and this "Untilled" window appears with a "blinking" edit cursor asking you 

to begin typing. It's that easy. 

Saving Documents 
When you have finished typing your document and are ready to save it to your disk, 

simply go up to the File menu and select "Save Document" or press OPEN APPLE-S 

instead: 

New noeumenl 
Open Ooeumenl 
Import lellt File 

Upon doing so, you will be asked to give your new document a NAME: 

a IGrflpl1i«::Writer/My.file§ 

Free 12001( Ollt of 161l[Jk. 
Ilisk 

L~ !>,.j!j,r!mwtnq 
L~ . .l()tLflrlwork 

L~ Slon 

~ (New Folder] 

Open 

Close 

I ( 
[( SalJe ] SmJlJ I](lCllmen~ Nflme!l: 

[@mmru (fmcel 

The default name "Untilled" appears at the bottom of this Save window. Note that it is 

highlighted. As usual, it can be edited by simply typing in a name or by clicking the pointer 

between characters and begin typing or backspacing. 
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SillJe Document Nilmed: 

I letter. to.Joel 

When ready, click on the "Save" button, or press the RETURN key (the "ring" around the 

button means it is the default button), and the document will be saved. You will then be 

returned back to your document. Notice that the TITLE of the window will change from 

"Untitled" to "Letter.to.Joe" (the name you enter). 

About the Save Window 
It is important to know some more things about the Save window. At the top you will be 

shown the name of the current PATHNAME. A PATHNAME is nothing more than an 

"address" on the disk of where you can find your documents. The Disk icon will be followed 

by a name that indicates the main directory to where your document will be Saved (and 

where you can find it in the future). You are also given the amount of disk space remaining 

(where "k" stands for 1,024 characters): 

G3l IGrilpilicUJriter 

Free 1201l1< out of 16001<. 

Those items in the window which are grayed mean they do NOT apply to the activity. For 

example, Prados, which is the Operating System File, has nothing to do with saving a 

document. Clicking on it does nothing. Also, program applications (as noted by the "hand" 

that is writing) will also be de-highlighted: 

Actual documents themselves will be de-highlighted since you can not save "into" them. 

These files are indicated by the Paper icon: 

:::~ MUJlrt\U!inu 

Saving your new document with the same name as "My.Drawing" will, of course, 

completely destroy this original file by writing over it with the new data. 

And finally, the "Cancel" button, when clicked, will simply return you back to your 

document WITHOUT saving the document. 
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Saving to a Folder 
What you are really trying to do when you save a document, is to save it iNTO A 

FOLDER. Thus, you locate the FOLDER you want (clicking on the Up or Down Arrows 

to scroll through a large list of them) and then click "Open" or press RETURN, or you may 

even double-click on the folder name. In any case, THIS is WHERE THE DOCUMEIIIT 

WILL BE SAVED! 

A Folder icon represents a SUB·DIRECTORY which in itself can hold other files, and 

these files can only be found by examining this particular FOLDER: 

a 1GrallilicWriter/My,nles 

You can recognize this as a SUB·DlRECTORY since the name includes slashes "/", 

each one meaning a "folder within a folder". Again, this will be the fOLDER your document 

will be saved in (when you click on "Save"). When a Folder icon is showing, the "Close" 

button will become activated. Clicking this will take you back to the previous FOLDER (if 

you have ventured a few folders deep). 

You can create a brand new folder by typing in a name for it then clicking on "New 

Folder". After this is done you would then type in the name for the document itself and 

Save it into this new folder. 

The "Disk" button is used by first ejecting your disk and inserting another disk. Clicking 

"Disk" will then read the new disk for all of its FOLDERS, and then you can carry on as 

explained above. 
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3.2 Retrieving Documents 

Closing a Document 
You can put away your document (in order to get to a different document) by clicking in 

its CLOSE BOX: 

(Note that if the top part of the window is white, instead of black, the CLOSE BOX will 

not appear. In this case, you will have to first click at the top of the window (on its title), and 

then the CLOSE BOX will become activated and visible). 

If you have been typing before closing your document and you haven't saved these 

changes yet, then you will be prompted as follows: 

SalJe changes before closing? 

Yes II 
No Cancel 

Clicking "Yes" (or pressing RETURN) will automatically save the document before 

putting it away. Clicking "No" will put the document away WITHOUT saving any changes. 

"Cancel" will simply return you back to your document for further editing. 

New Documents 
Once the current document is put away and the screen clears, you may then select "New 

Document" from the File menu which will bring up a blank, "Untitled" window, the same 

as if you just entered GraphicWriter. Or you can re-open a document which you have 

already created and saved prior to this session. 
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Opening Documents 
When a document is put away, you can then open a previously saved document by 

selecting "Open Document" from the File menu. In this case the following window will 

appear. Here we are choosing a FOLDER called "My. Files" to examine (as evidenced by 

the pathnarne "/GraphicWriter/My.Files": 

Open iJocument: 

a 1GrfillhicWriter/My.nles 

!lisk 

[ Open lJ 

Close 

ClllOcel 

Clicking the "Opera" button (or pressing RETURN, or double-clicking on the file's name, 

as shown above) will open the document. The new window will have the document's name 

as its title. 

Documents 
You can then start working with this document in the usual fashion. When finished, you 

have the option of Saving any changes and then Closing the window, or Close it and 

save it (or not) directly from the prompt window (explained earlier). 

Sometimes one might just want to "see" a document, or "copy" some of its text (or 

graphics), then close the document and bring up another and paste the copy into this newly 

opened document. Once you get the hang of it you will find there are a number of options 

available for creating and retrieving documents. 
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3.3 Other Doell 

Save Document As." 
You can work with an existing document by bringing it up, typing new data or making 

some changes to it and then selecting "Save Asooo" from the File menu. This will allow you 

to save this altered document to a different file (name). In this way you can make a "copy" of 

an entire document. The original document stays intact as the window's title then changes to 

the new document's name (that you entered in the Save window). This is how you can 

create "templates" and other such files that you would like to have saved aside. Many 

documents might actually contain the same "structure", such as "LeIlNhead" or reports, 

and by saving a "copy" you won't have to always create a new docurnent entirely from 

scratch. We shall cover TEMPLATES in more detail in a later chapter. 

Save As Text File 
By selecting "Save As Text" from the File menu you can save just the data you have 

typed (no pictures). A TEXT ONLY file will be created which will consist of just the numbers 

and letters. The fonts, sizes, styles and colors are "stripped out". In this way, the data can be 

moved over to other Apple ][ GS programs (or even to other computers). Note that saving 

as TEXT does NOT eliminate the "Save Changes?" factor on your current document. 

Importing Text Files 
A document can also be created from TEXT type files. This is the process you can use to 

bring into GraphicWriter any documents or TEXT created from othel programs. When you 

select "Import Texl File" from the File menu, another "Open" type window will be 

presented allowing you to choose a TEXT file (you may insert other disks during this 

"search"). You then select the TEXT file just like you were opening a normal document, but 

this time the DATA from that file will be inserted into your document. The insertion of the 

TEXT will occur at the current point of the "blinking" cursor. Thus, you should first position 

this cursor and then select "import Te)(\ File". After the TEXT is inserted, you are welcome 

to edit it (cut-copy-paste, etc.). You can also just bring up a "New Document" then import 

the TEXT. When ready you can Save this new document, or use "Save Asoo." to a 

completely different file for an altered document. 
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NOTES 
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Chapter Four 

Graphics 

Along with typing characters on your document using the Word Processor, you can use 

GraphicWriter to draw figures of various shapes, sizes and colors. 

When you create a document that is comprised of a mixture of text and graphics, you 

have the makings of real Page Making. You can create logos for your letterhead, charts for 

your business reports, sophisticated artwork layouts, or just have plain fun doodling. 

Accomplishing a successful graphic drawing is based entirely upon your understanding 

and usage of the various drawing "tools". Once you have learned all the options at your 

disposal and have absorbed them into your increasing skills, then you will be able to capture 

those great "ideas" in your mind, and duplicate them precisely on paper with speed and 

confidence. 
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4.1 The Drawing Tools 

Each DRAWING TOOL can be selected by simply clicking on its ICON (picture) at the 

bottom of the screen: 

The "A .. " (for ASCII) is used for what we call the TYPING MODE. Clicking on it (so that 

the square becomes highlighted) means you can then begin typing on the document. 

Clicking on any of the other squares means you will go into the GRAPHICS MODE. 

Next to the "A .. " we have the LINE TOOL After selecting it, the arrow pointer becomes 

a CROSS when you drag it up to the middle of the screen. This is also how you can tell that 

you are in the DRAWING or GRAPHICS MODE and that you can not type at this time. 

To use the LINE TOOL you first click and hold down the mouse button and DRAG the 

CROSS about the screen. A LINE will be drawn FROM THE STARTING POINT of 

where you FIRST clicked, TO THE ENDING POINT of where the CROSS is when you 

RELEASE the mouse button. You can "eyeball" the LINE until it is perfectly straight. Step 1 

shows a UN E being dragged towards the left. Step 2 shows the CROSS then being 

dragged slightly upwards. The liNE begins to straighten out. Finally, Step 3 shows the 

LINE all set to release the mouse button: 

1) -1 -------
2) t -1 -------
3) -1-------

Next to the liNE there are four SHAPE TOOLS: a rectangle; a rounded rectangle; a 

triangle and a circle (or oval). These tools work the same way, that is, you click and DRAG 

to draw with them. 

A final shape is maintained when you release the mouse button. 
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The next four FILL SHAPES work exactly the same way, but instead of drawing OJ 

"border", the entire area is filled in: 

The HAND tool is used for moving pictures about the screen. It works by clicking ON 

the picture, holding the mouse button down, and DRAGGiNG the picture with the !iAi'lD: 

A "ghost" picture moves with the HAND and when the mouse button is released, the 

picture will move from its original position to the new destination. If not satisfied with this 

position, simply drag it again to another place. 

The liNE THICKNESS is determined by selecting one of the 5 CI"lOSSES before 

you draw. Of course, only the NOI"·FllL SHAPES are affected byUNE THICKNC:SS 

since the Fill SHAPES are essentially "solids". 

+++ 
You click on one of these drawing pointers and then choose the TOOL you wish to 

draw with. To understand their differences, let's examine I"IOW the thinnest one can be 

utilitized to create the same effects as tbe thicker ones. Using the smallest CROSS pointer, 

draw a rectangle, then position the pointer just inside the upper le!t oxner and drag inio 

place a new, internal rectangle: 

Repeating this process creates a thicker "border" just as if you Llsed a larger CROSS. 

Therefore, as you draw with one of the larger CROSSES, adjacent multiple lines or "dots" 

are formed at the same time, thus yielding larger "rectangles". 
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4.2 The Paint Palette 
Drawing in color is done with the aid of what we call the PAINT PALETTE. This is 

called up on the screen by selecting "Paint Palette" from the Goodies menu or using 

OPEN APPLE-A (for "Artist"): 

D Point Polel le . 

J ••••••• e~@.@. 
O •• @9~®®e§.€D®O 

This is like an artist's tray of colors used during painting. The PAINT PALETTE can be 

kept on the screen as you are drawing and can be moved about by dragging on its top black 

part. It can be put away by selecting "Hide Paint Palette" from the Goodies menu, or by 

clicking in its CLOSE BOX. (Clicking on the title of your document at the very top of the 

window also puts the PAINT PALETTE away). 

Selecting a Color 
A COLOR is selected by simply clicking in one of the 26 colored ovals. A check-Ymark 

next to the oval signifies that it has been selected. Also, the selected color will appear in the 

COLOR BOX at the bottom of the screen. All subsequent typing or drawing will be 

displayed in this color. 
\ Color: 1\ 

Note that DOUBLE·CLlCKING a colored oval on the PAINT PALETTE will select 

that color and put the PALETTE window away. 

Typing in Colors 
The way to type in color is by first selecting one from the PAINT PALETTE just prior to 

typing. You can change the color of existing text by highlighting it and then selecting a color. 

Note that the text will remain highlighted and appear in an INVERTED color until you click 

the mouse to reveal its true color. 
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4.3 Painting Modes 
There are 3 PAINTING MODES. The current MODE will always be checked on the 

Goodies menu: 

HEAVY PAINT is very simple to understand. Any color you draw with will paint directly 

over any drawings underneath it. 

WATER COLOR results in "mixed" colors when painting over a different color than the 

currently selected drawing color. The drawings below it will often "come through" resulting in 

bizarre combinations of colors. However, the primary purpose of WATER COLOR is TO 

LET THE BLACK SHOW THROUGH. In Figure 1, below, we have drawn 2 rectangles in 

black: 

2) 

and then connected the corners, in Figure 2, using the LINE TOOL This yields the illusion 

of a "solid" object. 

Now, we select "Water Color", choose a color and then surround the whole picture with 

a new rectangle. Upon releasing the mouse button, the picture is "painted" with this WATER 

COLOR and the BLACK lines show through: 
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DYE simply paints over any BLACK pal1s of a picture. On an empty screen, a drawing 

done in DYE will end-up being transparent, but when you paint over a picture that contains 

the color BLACK, then just the BLACK portions of the drawing underneath become DYED. 

If we paint over oLir example box, as in Figure 1 below, then just the BLACK lines become 

colored, shown in Figure 2: 

H 
On the Display menu YOLi will find "Hide Red, Blue, Green or Yellow". 

Hide Red 
IJide Biue 
Hille Green 
Hille Vellom 

vlilJing Color 
Block U' White 

Selecting one of these will temporarily HiDE that particular color from the screen. The 

Display menu will then change to "Show Red" or "Show Blue", etc. Re-selecting one will 

once again SHOW that color. This is how you can view various colored OVERLAYS. 

Living or Black & White 
You can also select "Black & White" from the Display menu in which case the entire 

screen will be displayed in black and white, or shades of gray where there are different 

colors. Selecting "living Color" returns the screen back to all color again regardless of 

which colors were previously "hidden". 

"living Color" therefore SHOWS All COLORS, as if you selected them from the 

menu one by one. "Black & White" will override any "Show Colors" and HIDE them all 

at the same time. 
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4.4 Objects 
When you draw a shape, it becomes what we call an OBJECT. This means it is 

INDEPENDENT from the rest of the document or other OBJECTS (pictures). 

Selecting & Changing an OBJECT 
This is proven by the fact that you can change the size, position or color of an OBJECT 

without disturbing the others. This is done by SELECTING the OBJECT (clicking on it with 

the HAND TOOL): 

A "marquis" type border will surround the 0 BJ ECT telling you that it is currently 

SELECTED, which means you can now do various things with the OBJECT. (You already 

know how to drag it with the HAND to another position). 

An OBJECT'S liNE THICKNESS can be altered by selecting the OBJECT and 

then immediately selecting a different CROSS. 

An OBJECT can be RE-SIZED by holding down the CONTROL key while dragging it 

with the HAND TOOl: 

,,··· .. · .. ·· .... ·········· .. ··············0 

An OBJECT can also be ROTATED by selecting "Rotate" from the Goodies menu. 

This is ideally used on TRIANGLES to obtain "arrows" of different direction. (The following 

example is deceiving: a single figure being rotated on the screen has NO horizontal motion): 

~ 

1) 2) 

You can change an OBJECT'S COLOR by clicking a different colored oval on the 

PAiNT PALETTE. Likewise, the DRAWING MODE for this particular OBJECT can be 

changed by selecting "Heavy Paint", "Water Color" or "Dye" from the Goodies menu. 
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Selecting Multiple OBJECTS 
You can select a number of different OBJECTS at the same time by holding down the 

SHIFT key while clicking on them one by one. Each one of the OBJECTS will appear with 

a "marquis" frame. 

These selected OBJECTS will then behave as a GROUP. You can change all their 

COLORS to the same color, as well as change their UNE THICKNESSES or 

DRAWiNG MODES. You can move ALL at them in unison by holding down the SHIFT 

key while dragging. However, if you try to RE·SIZE anyone of them (with the CONTROL 

key), only that one particular OBJECT will be altered since the others will then become 

"de-selected". 

Cut/Copy/Paste with OBJECTS 
Just as you highlighted text and performed Cut, Copy or Paste, so can you select an 

OBJECT (or multiple OBJECTS with the SHIFT key) and choose Cut or Copy from the 

Edit menu. The copied OBJECT will appear on the Clipboard, replacing whatever was 

there before it. As you'll recall, the Clipboard's contents can be viewed as desired by 

selecting "Show Clipboard". 

When an OBJECT exists on the Clipboard, you can then select "Paste" from the Edit 

menu and the OBJECT will reappear at the top-left corner of the CURRENTLY 

SELECTED REGION. For example, if you Cut an OBJECT from your document, and 

then select a different REGION, the Pasted OBJECT will be placed at the top-left position 

of this REGION -- no matter what Page you are on (or have scrolled to). You may, of 

course, DRAG a Pasted OBJECT away from this position by using the HAND TOOl. 

When you Paste an OBJECT directly on top of another OBJECT, you might wish to move 

it away (using the HAND) in orde( to expose any "hidden" OBJECTS beneath it. 
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4.5 Regions 
A REGiON can be simply defined as "an area". A REGiON is usually comprised of a 

"group" of multiple OBJECTS that form a single picture. 

Typing REGIONS 
The simplest REGION is called the TYP!NG REGiON. When you create a new 

document, a large TYPING REGION is automatically cl·eated which essentially "covers" 

the entire document. You don't have to worry about it. You just keep typing and as you hit 

RETURN, the lines of text keep growing and growing. 

Bottomless REGiONS 
This beginning TYPING REGiON is also known as a BOTTOMLESS REGION in 

that an imaginary "rectangle" surrounds the whole document, with no tangible BOTTOM. 

You can virtually type forever downwards. And just as you can keep typing, so call you keep 

drawing and adding OBJECTS into a BOTTOMLESS REGION. 

Boxed REGIONS 
A BOXED REGiON is one that does have a bottom. It is finite to the degree that if you 

were to type in this REGION, you would eventually come to a point where you could no 

longer type, that is, the REGION'S boundaries will restrict the typing to the specified 

dimensions. 

A BOXED REGION is most often used when you want to confine certain OBJECTS 

within a particular area and act on them without disturbing any others. Such is the case of a 

complex drawing that is complete to your satisfaction, and you wouldn't want it to be 

changed. The "set" of OBJECTS can be copied and sent to other places on your document, 

into other REGIONS or even to other documents (via the Clipboard or GraphicWl"iter 

Scraps). 
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Creating a New REGION 
As previously mentioned, a new, "Untitled" document begins with a BOTTOMLESS 

TYPING REGiON. To create and define a totally NEW REGION, simply select "New 

Region" from the Regions menu and a default "rectangle" will appear on the screen: 

The annual report looks encouragingl 

(a II",.. Region Ar",,) 

The OBJECT MODE 
REGiONS have 2 different MODES. The OBJECT MODE is fairly straight forward. 

The REGION is simply made up of a collection of OBJECTS brought together to form a 

single picture. You create and draw the OBJECT directly within the REGION: 

E0] 
LB4-

The OBJECTS within a REGION can be Cut or Copied. You may also create an 

OBJECT outside the REGiON, Copy the OBJECT then Paste it into the selected 

REGiON. 

Therefore, the purpose of a REGION is to "group" OBJECTS together. The REGION 

will then behave as a single entity, which we shall learn more about in a moment. The 

reasons why you would want to use REGIONS will become much more evident in the next 

chapter concerning Page Making. 

42 



The CANVAS MODE 
The CANVAS MODE is quite different. This is where you draw within the selected 

REGION using the PAiNT BRUSH TOOL to do "free hand" drawings: 

You must understand that the drawings performed in the CANVAS MODE are NOT 

OBJECTS. The drawings are nothing more than "dots on the screen". These "dots" 

CAN NOT BE MOVED nor can they be re-sized. They merely form a picture within the 

REGION and have become "blended" into the area. You can, however, draw right over 

them, or erase them by selecting and drawing with "White" paint. You may also Cut or 

Copy an ENTIRE CANVAS REGION and Paste it into another CANVAS REGION, 

but NEVER into an OBJECT REGION. 

IMPORTANT RULE: Once you have selected either the OBJECT MODE or 

CANVAS MODE anal halfe started to alraw in the REGION, you may NOT reller! 

to the other MODE while working in thaI REGION. 

Black on White/White on Black 
The "normal" mode for most applications is "Black on White" which means "black text 

on white paper", much like a typewriter. However, GraphicWriter allows you to do the 

reverse by selecting "White on Black" from the Regions menu: 

This is Biack on White 

This ONLY EFFECTS NON·COLORED TEXT and pertains to the ENTiRE 

REGION. You can subsequently paint "over" any part of the REGiON. You can revert to the 

opposite by re-selecting the other "inversion" from the Regions menu. 
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Selecting & Operating upon REGIONS 
A REGION becomes selected by holding down the OPEN APPLE key while clicking 

on it with the HAND TOOl. The OPEN APPLE key is necessary so as to distinguish the 

REGiONS from OBJECTS. Upon selection, you can operate on the entire area of the 

REGION at once, such as RE-SIZING it to different dimensions by holding down the 

OPEN APPLE plus the CONTROL key at the same time while "tugging" on the REGION 

with the HAND. Note that by using the SCROLL BARS it is possible to create a REGION 

which is larger than the viewable screen. You would alternately RE-SIZE and SCROLL. 

However, due to memory limitations, a CANVAS REGION may NOT be larger than 8 

inches wide by 10 inches long. 

You can change the REGiON from "Boxed" to "Bottomless", or you may choose to put 

a BORDER around a REGION by selecting "Framed" from the Regions menu. This will 

draw a BOUNDARY FRAME, which can thereafter be removed by selecting "Unframed". 

Selecting "Show Regions" will allow you to see the positions and sizes of your 

REGIONS in the form of rectangular "frames" on the screen. Thereafter, the Regions menu 

will say "Hide Regions" which will, of course, remove the viewing "frames". 

Rules 
The OPEN APPLE key always pertains to REGiONS. If you do NOT use the OPEN 

APPLE key, then you will be acting upon OBJECTS or TEXT. 

The CONTROL key gives you "control" of a REGION or an OBJECT. 

The HAND is used for SELECTING, MOVING and RE-SIZING both REGIONS 

and OBJECTS. 

The SHIFT key, while used to select MULTIPLE OBJECTS or TEXT, unfortunately 

may NOT be used to select multiple REGIONS. However, you Q.illl Copy OBJECTS 

within REGIONS, or CANVAS pictures, individually into or out of the Clipboard or 

GraphicWriter Scraps and Paste them elsewhere as desired. 
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Chapter Five 

Page Making 

Page Making is the term used for designing and creating a "mixed" document that 

contains both typing and drawings, that is 10 say, text plus graphics. The REGIONS are laid 

down and the "pages" begin to take form. 

With GraphicWriter you can type on your document or draw on it. You can type labels 

for your pictures and so forth. The end-results are aesthetic and professional documents that 

range from simple "doodles" to fancy invitations or letters, special promotional artwork, 

business reports showing trends by aid of graphs and so forth. 

It's all quite up to you what kinds of documents you'll want 10 create. All of the drawing 

tools are at your disposal, and you are limited only by your imagination. 
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5.1 Page Design 
For the advanced user or desktop publisher, REGIONS become almost mandatory for 

sophisticated page layout. For example, multiple text columns (required for creating a 

NEWSLETTER) can be defined by laying down REGIONS for these columns: 

Whole PllIge-

M .... 210~6:;;J~ 
"ilOll_,.....,."a.. ....... 1I 
'!lI:>~~T'lSo .... 

Column 1 f--"'--" 
IimoiI1laEJ1it:::liwl!P~ 

m!l1i!t!:IlrB1:!till::l1l1IiI:i9"EI 
~""'lIIIJoIoIlJiO_ 

The :2 COLUMNS on the example document, pictured above, are independent from 

each other. You can type just in Column 1 (by clicking the POINTER there) or you can 

type in Column 2. You can Cut or Copy from one REGION and Paste into the other. 

You can choose separate colors for the entered text as well as separate justifications for 

each REGION. Changing one REGiON will not alter the other. In this way, a body of text 

could be typed in one column with the writing carrying over and continuing on in the other 

column. 

You can create as many columns as you wish, with each REGiON having a unique size, 

and you can scatter these REGIONS around a page as well as using multiple pages. (You 

may want to refer to "6.1 Page Setup" in the chapter on Printing to learn how you can 

change the actual page lengths). 

Documents can also be created that are "mixed". In the following example we see two 

REGIONS of text along with a third REGION dedicated to some artwork drawings: 

Big Book Sale 

Saturda.y 3:00 PM 
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5.2 Text p~us Graphics 
The basic rule to remember when combining text and graphics pictures is that the 

pictures will always "override" the typed text. This is because a drawing is really a "painting" 

and will usually cover-up the text. Of course, a WATER COLOR or DYE will change the 

apparent color of any underlapping text (until you move one of these OBJECTS away). 

Typing Over Pictures 
As you are typing, the characters might run right under an OBJECT, as the text will tend 

to "disappear". In fact, you might even see a "blank line" across the screen during 

backspacing of text. What this means is that because you are in the TYPING MODE at the 

time, there will be an illusion of parts being "erased". You will experience this whenever you 

are typing and there are pictures that "get in the way". 

To review the pictures or text, that is, to see what the document "really" looks like, all you 

have to do is click on the "Update" button at the bottom right corner of the screen: 

This will show the OBJECTS in their proper and full pictures, in which case if any text is 

underneath them, the OBJECTS will "smother" the text so that the text will not be seen. 

(except for most Water Color and Dye OBJECTS). 

TEXT within REGIONS 
The text entered into a BOTTOMLESS or BOXED REGION can be operated upon 

with the normal editing functions such as cut & paste, highlighting and changing font, size or 

color, and so forth. However, the REGION Can also maintain a set of TABS and MARGINS 

and because of this, the real power of GraphicWriter begins to be noticed. 

When we create a NEW REGION, the MARGINS are set, as a default, to the left and 

right boundaries of the REGION, as illustrated in the following example: 

47 



Come olle, come I'll! to the big evel1t 

You'll recall the rule that the RULER you see is for the current paragraph. Well, in this 

case it's our REGION! The LEFT and RIGHT MARGINS are set at the 1 inch and 5.5 

inches MARKS. As with any paragraph, dragging the RIGHT MARGIN MARK to a new 

setting will alter the text within that REGiON: 

Come one, come all 
to the big euent 

This is the same Word Processing "test" we performed much earlier, except the 

difference here is that we can actually DRAG this entire REGION about the screen: 

Carefully notice that not only has the text moved along with the REGION, but the 

MARGIN MARKS on the RULER have also been adjusted to satisfy the new position! Now, 

here's where the real Page Making begins to take shape! You can scatter REGIONS 

throughout your document's Pages, creating these "typing fields" wherever desired. 
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Mixing Text and Graphics 
You can also combine GRAPHiCS pictures within the same REGION containing 

TEXT. For example, if you had a drawing in one REGION, and typed a "label" in a separate 

REGION just below the drawing, then if you wanted to move QQ1b. the drawing and label to 

another position on the page (or to another page), you would have to move them 

individually. 

However, the correct way to do this is to COMBINE them all into one single REGION, 

making this unit much easier to work with: 

[orne olle, come ali 
to the big euent, 

In the above example we see that the TEXT is within the same REGION (the CANVAS 

TYPE, evidenced by the fancy artwork drawings) as the PiCTURES. This entire REGION 

can be moved about the document. Of course, the TEXT in the example has become "dots" 

within the CANVAS and can only thereafter be COPIED as a PICTURE (to another 

CANVAS) or ERASED (by using the color WHiTE). You realize, therefore, that this "text" 

can D.Qi be "highlighted" and acted upon. It has become nothing more than a picture, just as 

if you took the brush and drew all of the "dots" 10 form the words. 

Cut-Copy~Paste 

But you Qilll use Cut, Copy or Paste on any TEXT within the OBJECT REGiONS. 

The TEXT is called REAL TEXT in that it is considered to be "loose" and movable. This is 

best understood when you think of each REGION as being miniature "documents" within 

themselves. You can take the TEXT from one REGiON and Paste it into another: 

@tf1ii9~ t...---------
~ Books at 112 price q 

0 
HE GlllN "A" 

REGION "B" 
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5.3 Overlays 
An OVERLAY is the term used for when we "mask" an OBJECT or a REGiON by 

placing a WATER COLOR or a DYE OBJECT directly over it. (Of course, using HEAVY 

PAiNT will cover an OBJECT or REGION completely). 

Let's take our previous example and place a new WATER COLOR MASK over our 

text: 

As expected, the BLACK will "shine through". 

We can perform further OVERLAYS by again "masking" some more text, such as 

shown on the word "event": 

Dye 
Molle 1) 

Through the use of the "typing fields" and OVERLAYS, sophisticated artwork can be 

obtained. Keep in mind as well that when your creative ideas come to life in the form of a 

really good drawing, make Copies of them for safe-keeping. After all, they can be used 

again on other documents! (See 5.5 Templates). 
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5.4 layouts 
You'll recall that "Show Full Page" can be selected from the Page menu in order to 

view a miniature representation of the PAGE on which you are currently working. This 

process proves very valuable when applied to Page Making. 

Using "Show Full Page" 
When brought up on the screen, Show Fuli Page presents for your inspection the 

"overall view" of a document Page: 

::::::::::::::::::::::::::::::::::::: ..... ~ 
:::::::::::::::::::::::::::: ....... "~ 
',',','.',',',',',',',',',',',',',',',',',',',',',',',',',',',',','. 
'.',',',',',',',','.',',',',',',',',',',',',',',',',',',',','. 

~-------------------

OK 
__ --':::====~_.-J 

Lines of TEXT in this window will be displayed as "waves", as shown above. The 

window represents a single page, about 8 1/2 inches across (the "viewable" section of the 

document window, which will be just a portion of a wider document) and you can view 

different pages by first scrolling to them prior to selecting "Show Full Page". 

Rearranging the layouts 
One of the best usages for Show Full Page is that, by using the HAND, you can 

actually drag and maneuver the OBJECTS or REGiONS about the page, as shown in the 

example above. In this way, Page Making becomes much easier to accomplish. The 

OBJECTS or REGIONS can also be Cut, Copied or Pasted directly on the window (or 

into the Scrapboard). Any other process that you can perform on the "regular" document 

window with an OBJECT or REGION can also be done on Show Full Page. The ONLY 

function you can not do is to RE-S!ZE an OBJECT or REGION during Show Full Page. 
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5.5 Templates 
A TEMPLATE is the term used for a document which serves as a "model" that can be 

used to create similar type documents. This is so you don't have to keep creating the same 

drawings or layouts over and over. 

Creating a TEMPLATE 
It is very easy to create a TEMPLATE. All you do is perform your drawings and then 

Save it back to the disk. For example, a document that has a logo at the top can be used as 

Letterhead stationery. Then, you open up this TEMPLATE and begin typing a letter. 

When ready to save this new document you MUST select "Save As .. " from the File menu. 

This allows you to save the document to a new file with a different name. But take caution: 

Should you use "Save Document" to save it, you'll be saving the TEMPLATE itself! The 

TEMPLATE will still have the typing on it and therefore become "ruined"! 

To avoid this problem, you might want to save away another COPY of the TEMPLATE 

so that the original NEVER gets altered. 

Examples of TEMPLATES 
The main reason for creating TEMPLATES is to avoid doing extra work. When you 

create a document or a report containing numerous REGIONS all carefully laid out, or 

sophisticated drawings, or special areas of the document set aside for graphs, etc., then 

stashing this "raw" document aside will allow you to use it again. 

Of course, if the ONLY difference amongst your documents is the actual text you type in 

the REGIONS, then you could always bring up one of them, highlight the text and Cui it 

out, then begin typing anew. 

It is also a very wise thing to set aside a FOLDER on the disk for special drawings, 

artwork, laid out REGIONS and so forth. The extra time spent in creating TEMPLATES 

and FOLDERS may very well prove worth it. 
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5.6 GraphicWriler Scraps 
GraphicWriter Scraps is a collection of sample drawings combined together within a 

second Clipboard. This Scrapboard, as it is often called, can be brought up on the 

screen by selecting "GraphicWriter Scraps" under the Apple @f! menu: 

lof4 

A picture in this Scrap board is like a "frame on film". The number of the picture is 

shown along with the total number of pictures (1 of 4, etc.). You can move through the 

series of "frames" in the usual manner of clicking on the arrows to scroll up or down, or by 

clicking in the scroll bar (gray area), or by dragging the scroll "thumb". 

A picture can be Cut or Copied (by using the Edit menu) from your document and into 

the Scrapboard, or a picture can be Cut or Copied from the Scrapooard and then 

Pasted into you r docu me nt. 

There is an important rule to remember which is called the fRONT WINDOW. If the 

Scraps window is the frontmost window at the time, the editing functions (Cut, Copy or 

Paste) apply ONLY to the Scraps window and NOT the document. When you CLOSE 

the Scraps window (or click on the document window), then the document itself becomes 

the FRONT WINDOW and all editing functions behave as usual upon the document. 

You can store various pictures of your choice into the GraphicWriter Scraps so that 

all of your documents can access and share them. 
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Chapter Six 

Printing 

Once you have created your document, with all its fancy typing and drawings with colors, 

objects and regions, you can then print the document using your special ImageWriter II color 

printer (or a compatible printer) or your daisywheel. 

Printing your document is very easy. You have a number of choices in how you would 

like this to be done. It's as easy as using a copier machine, and as simple as clicking the 

mouse. 
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6.1 Page Setup 
Printing your document is accomplished by first selecting "Page Setup" from the File 

menu. Upon doing so you will be presented with the following window: 

Printer: 
@ ImageWriter 
o ImageWriter I! 
o Laser-Writer 
o DaisyWheel 

[2J Page Numbers 

OK 

Page Setup 

Quality: 
o Draft 
@ Standard 
o High 

Paper: 
C~) US Letter 
o US Legal 
o A4 
o Computer 

[2J Headers [2J Footers 

( Cancel J 

The Page Setup window allows you to choose various ways of printing. You may bring 

up this window at any time just to "set" the parameters. However, there may be times when 

you'll want to make changes to these parameters just prior to printing special documents. 

PRINTER represents the type of printer you will be using. You can choose the 

imageWriter, the ImageWriter II (which can print in colors), the LaserWriter, or a 

Daisywheel type printer. (The latter can only print in DRAFT). To select a printer, simply 

click in one of the "radio" buttons. 

QUALITY represents the type of printing you want to use. The DRAFT button signifies 

that you want to print the TEXT ONLY. This, of course, means that NONE of your graphics 

drawings will be printed nor will the TEXT be able to be printed in the different fonts, sizes 

or styles (except bold and underline). This printing mode is used most often for business 

letters and reports. 

STANDARD represents the normal mode for printing graphics. This mode does allow 

the fonts, sizes and styles of your text to be printed. HIGH QUALITY mode is a 

"double-pass" graphics printing which results in a much sharper picture than with 

STANDARD (although this takes a few moments longer to accomplish). 
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PAPER is for setting the paper length of each PAGE of your document. Note that you 

can control this length while you are creating a document. The Page Number on the 

screen, as well as Page Breaks, will be affected by this length. US letter is your normal 

8 1/2 by 11 inches while US Legal is 8 112 by 14. A4 stands for the common European 

size. Computer represents paper that is 15 inches wide. Note that you can only print 15 

inches wide PROVIDED you are using the Wiele !mageWriter. 

PAGE NUMBERS, HEADERS and FOOTERS are selected individually by clicking 

in their respective "boxes" (until a check appears). These are additional functions which 

allow you to print the Page Number, Header or Footer for ili!ctJ. page during the actual 

printing. Clicking a checked box a second time will "un-check" it. 

Clicking the "OK" button will accept the parameters, saving them for future printing, and 

then return you back to your document. Clicking "Cancel" will return you back to your 

document WITHOUT saving any changes you may have made to the parameters. 

Important Note: These Page Setup parameters are always saved uniquely for each 

document. You can therefore have many different documents, all with separate settings. 

Should your printing not quite come out as desired, then abort the printing and bring up 

the Page Setup window, select the appropriate option, then continue printing. 
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6.2 Print Setup 
After assuring the Page Setup parameters are satisfactory, the very next step towards 

printing is to select "Print Setup" from the File menu. Upon doing so you will be presented 

with the following window: 

Print Setup 
Colors: 

~Illflci< ~Illue ~ Red ~ Yellow ~ Green 

Screen Tones: 

® None 075'7. 050'7. o 25'7. 

@J form Feed o Cut Sheet Copies 1[11 1 

( START ) ( [flncel ) 

The COLORS boxes allow you to choose which of the main COLORS you would like 

included in your printing. You choose a color by clicking in its box (until it becomes 

checked). You can de-select (un-check) a COLOR by clicking the box a second time. If a 

COLOR is not checked, then it will be excluded from the final printing. In this way it is 

possible to print COLORED OVERLAYS by printing your document a number of times. 

Each time you can print by selecting different combinations of added or removed colors. 

SCREEN TONES represent the degree of "screening" to be done during printing. This 

is as if a screen or "grid" of a specific DOT DENSITY was laid over the document, allowing 

only certain TINTS to show through. This is measured by the percentage of SOliD 

B LACK. The following example illustrates a descending scale of SCREENING upon the 

color BLACK: 

NOlle 
(lOIl'7.) 

75'7. 50'7. 
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FORM FEED is your normal type of paper feed where the printer sends the specially 

prepared form paper on through during printing. CUT SHEET is where YOU manually feed 

each sheet of paper during printing, one by one when asked to do so. 

The number of COPIES you wish to print can be entered by editing the COPIES box. 

Clicking "Cancel" returns you back to your document WITHOUT saving any changes to 

the Print Setup parameters. 

Clicking the "START" button will save the current parameters and begin printing 

according to all of the parameters from both the Page Setup and Print Setup windows. 

You can thereafter abort the actual printing by pressing OPEN APPLE-PERIOD. 

Remember, these Print Setup parameters are saved uniquely for each document. 
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Other Offices 

GraphicWriter is actually only one of a handful of "modules", all of which can be 

combined into one package. You can move from one OFFICE, as they are called, over to 

another, bringing the data with you as you go. The documents you type can be used entirely 

by GraphicWriter, or you can transfer them into the other Office Modules. A powerful 

package is created when the modules are used altogether. 

Office Works™ 
By selecting "Other Offices" from the File menu, you can move over to another 

MODULE in the Office WorksTM Series from DataPak (or just "quit" to other ][ GS 

programs such as the Finder, etc). 

Office Works contains a fascinating program called "Central Files" which will accept 

the documents you created in GraphicWriter and file them into animated file cabinets. 

Here you click open a drawer of the filing cabinet and out fans the folders of your clients. You 

can store your documents right into your clients' folders! 

Along with this unique, yet intuitive filing system, you can also perform mail merge 

(printing form letters and labels). 

Office Works™ contains yet another program called "Ledger Set" which will handle 

all of your accounting needs, receivables, payables, inventory, etc. It has a powerful 

spreadsheet, graphs and statistics generator. 

Call DataPak to find out more information concerning the Office WorksTM Series 

Modules and other new products available for your Apple ][ GS! 
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APPENDIX A ~~ Bitmap Files 

Certain video scanning devices that DIGITIZE images (translate real life pictures into 

patterns a computer can recognize) have the capability of creating a disk file that, when 

loaded into the computer's screen memory, will display the digitized picture. Such files are 

called BITMAP FiLES. Essentially, they contain BITS ("dots") that constitute a graphic 

picture for the Apple ][ GS. GraphicWriler has the capability of importing these BITMAP 

FILES provided they have been generated from HIGH RESOLUTION graphics. For the 

GS this is 640 PiXELS ("dots") per line with 200 lines per screen. 

To Import a Bitmap File: 
1) SELECT or create a CANVAS REGION (you can ~ import a 

Bitmap File into a CANVAS REGION). 

2) Select "Imporl Bitmap File" from the Goodies menu. 

3) A standard file selection list window will be displayed. Select the file you 

wish to import. 

A standard Bitmap File contains 32,000 characters which comprises an entire single 

GS screen in the High Resolution mode. The initial size of your CANVAS REGION is 

unimportant. The entire 640 X 200 matrix of "dots" is imported into memory. A smaller 

CANVAS REGION can be "stretched" in size in order to see more of the imported picture. 

Exporting Bitmap Files 
It is also possible to EXPORT a Bitmap File from GraphicWriter to another program 

or device (providing, of course, they have the capability of "excepting" such a file). To do this, 

simply SELECT a CANVAS REGiON and then select "Export Bitmap Files" from the 

Goodies menu. As usual, you will be asked to enter a new name for the file just prior to 

saving it. 

NOTE: Since Bitmap Files require large amounts of disk space, it is NOT 

advisable to use "import" or "Export" just to transfer pictures between 

GraphicWriter documents. Instead, use either Cut/Copy/Paste or GraphicWriler 

Scraps. 



APPENDIX B ~~ The Master Palette 
Since GraphicWriter uses "Super Hi-Res" graphics, there are certain restrictions 

applied to the selection of COLORS. In the "Super Hi-Res" mode, the GS can only 

display FOUR unique colors per screen line, and although this restricts the solid color 

spectrum, it is a necessary trade-off for good quality graphics or word processing. 

GraphicWriter behaves like it uses more than FOllR COLORS by employing a 

technique known as DITHERING. This method, commonly used in the printing industry, 

blends the different colored "dots" into PATTERNS that give the appearance of different 

hues and shades. For example, the color PURPLE is created by displaying alternate RED 

and BLUE "dots". ORANGE is created with YELLOW and RED "dots", and so forth. 

Changing the Master Pa.lette 
There may be times when SOLID COLORS will be preferred over DITHERED 

COLORS. For example, one might be designing a layout which will only have one or two 

colors for the camera-ready artwork at the printing press. In this case, the restriction to four 

colors (where WHITE and BLACK are two of them) is more desirable since solid, 

undithered colors are preferred. 

By selecting "Set Master Palette" from the Display menu, the following screen will 

be presented: 

Set Master Palette 

@ Dithered o Solid (olors 

(olor 1: IZJRedI IZJ Blue IZJ Green 

Color 2: IZJ Red IZJ Blue IZJ Green 

( OK ) ( [ancel J 

If you select "Dithered", colors will be displayed on your document using the 

DITHERING technique (described above). Note that the color selections have no meaning 

when Dithering is selected. 



By selecting "Solid Colors", your document will be displayed using FOUR 

NON-DITHERED COLORS. White and B!ack are always chosen for two of the four 

colors as White is necessary for "background" and Black is necessary for "outlines". But, 

you can choose Red, Blue, Green, or a combination of all three for the remaining two 

colors. 

Red, Blue and Green are offered as choices that represent the actual colored "beams" 

that reflect on your monitor. By selecting different combinations, you can obtain the following 

solid colors. (Note: An X means the color box is checked while "'0" means it is un-checked): 

Solid Color Table 

RED BLUE GREEN SQLID CQLQR RES!.!LT 

X Red 

X Blue 

X Green 

X X Violet 

X X Turquoise 

X X Yellow 

X X X White 

Black 



APPENDIX C ... Colored Printing 
GraphicWriter version 1.0 supports the Apple ImageWriler and ImageWriter II 

printers, as well as some Daisywheel "letter quality" printers (which can only' print TEXT). 

The LaserWriter will be supported pending Apple Computer's release of the actual 

laserWriter driver software. 

Of these printers, only the imageWriter II is capable of printing in COLOR. Printing a 

colored document to a "black and white" device requires some discussion: 

How Colors will Print 
You can determine the exact way GraphicWriter will print colors to various printers by 

understanding three general rules: 

1) If the selected print device is the ImageWriter II, the document is printed with the 

identical colored patterns as shown on the GS screen. 

2) If the selected print device is the ImageWriter or LaserWriter, colors will print in 

Black and White patterns as follows (See Appendix B -- The Master Palette): 

A) If DITHERED is selected for the Master Palette, colors will be 

represented by various shades of gray, depending upon the original 

colors' relative lightness and darkness. 

B) If SOUD COLORS is selected for the Master Palette, then all 

solid colors are printed as solid Black and patterned colors are 

printed as Black DOTS. 

3) If SCREEN TONES has been selected (from Print Setup), only the SOUD 

colors are affected. If DITHERED is selected for the Master Palette, then only 

Black is affected, whereas if SOUD COLORS is selected, then Black and ALL 

SOUD COLORS will be affected by the SCREEN TONE selection. 



Separation 
GraphicWriter is an excellent tool for preparing multi-colored copy for printing. 

However, it's important to plan your document in advance, keeping in mind the various 

methods for printing, in order to achieve the desired results. 

For example, if you are going to design a two or three colored promotional piece, it is 

best to force the Master Palette into SOUD COLORS (See Appendix 8). Then, you 

would print each OVERLAY one at a time. By selecting one of the colors from the Print 

Setup parameters (and remember, Black ill. a color), only those specific colored poriions of 

the artwork document will be printed in SOUD BLACK which is exactly what is required for 

your camera-ready copy. 

A Daisywheel printer, of course, can J2..ObL print TEXT characters illlii. only in black and 

white. The printer's "wheel" (which is nothing more than a metal ball with an engraved 

alphabet) strikes a ribbon to print a character. It is therefore virtually impossible to print any 

typ8 of graphic "dots". 

However, Style variations of BOLD and UNDERLINE are supported. 

NOTE: DataPai, Software, Inc., only guarantees that GraphicWriter will work with the 

Apple imageWriter and imageWriter Ii. The laserWriter will be supported by 

Cin3!.ltlicWrite,· in version 200 and above. 
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iJocuments 25 
Documenls, Closing 29 
Documents, 
Documen!s, 
Documents, 
Documents, 
Documents, 
Documenls, Save jl.,s,"" 

Documents, Savillg 26,52 
Documents, Wow!{ing with 30 
Dm.lbie-clicl{ing Word'S 12 

Painl Paielte 36 
21 
56 

Drawing lines 
Dn;lIl'!ing (Simpije reci5lllgles) 6 
iJlrOlwil1g Reretallgles 5,34 
Drawing Too!s 34 
Drawing Triangles 
Drawing Thickness 35 
Drawing Ovals 34·35 
DYE 37·38 
Eom Menll 013 

TEMPt/liES 52 

Folder icon 28 
folder, Closing 28 
folder, Creating 3 New 28 
folder, Saving) ~o 28 
fonts 12 
Fo!),ers 1Im:l Headers 23 
Fooler;;; ami He",\!en" Prilliing 57 
FORM FE.ED·Cut S!jf~et 59 

i5 

35 
HAND TOOL (objects) 39 
Headers & Footers 23, priniing 57 
HEAVY PAiNT 37 
Helpflll Rules (REGIONS) 44 



Hiding Colors 38 
HIGH QUALITY Printing 56 
Highlight Text, Other ways of i 2 
HIGHLIGHTING ENTIRE DOCUMENT 12 
Highlighting Text 11 
I-Beam 11 
ImageWriter 21,56,57 
Importing Text Files 31 
Indentation, Paragraph 18 
Individual Rulers 15 
Justify Center 16 
Justify Full 16 
Justify Left 16 
Justify Right 16 
laserWriter 56 
leU TABS 19 
letterhead 31,52 
LAYOUTS 51 
LINE THiCKNESS 35,39 
LINE TOOL 34 
living Color or Black & White 38 
Main Screen 4 
MARGIN, left & Right 16-17,21 
Masking a REGION 48 
Menus 6-7 
MODES, CANVAS 46 
MODES, OBJECT 42 
MODES, PA!NTING 37 
MODES, TYPING 47 
MODES, Typing and Graphics 34 
Mouse, Using the 5-6 
Multiple Columns 46 
New Documents 9,29 
New folder 28 
Newslette. 46 
OBJECT MODE 42 
OBJECT'S COLOR 39 
OBJECTS 39 
OBJECTS, LINE THICKNESS 39 
OBJECTS on the Clipboard 40 
OBJECTS within a REGION 42 
OBJECTS, Changing 39 
OBJECTS, Cut/Copy/Paste 40 
OBJECTS, Pasted 40 
OBJECTS, FIE-SIZING 39 
OBJECTS, ROTATING 39 
OBJECTS, Selecting 39-40 
OBJECTS, WATER COLOR 49,50 

Opening Documents 30 
Other Documents 31 
Other Ways to Highlight Text 12 
OVERLAYS 38,50 
Overlay MASKS 50 
Page Breaks 23 
Page Breaks, Inserting 23 
Page Breaks, Removing 23 
Page Design 46 
Page Making 45,51 
Page Numbers 21-22 
Page Numbers, Printing 57 
Page Setup 56 
Page Setup parameters 57 
Page Setup window 56 
Page, Pin-pointing exact 21 
Page, Show Full 24,51 
Paging 21,51 
Paint PaleUe 36 
Paint Palette, Hiding 36 
PAINTING MODES 37 
PAiNTiNG, Dye 37-38 
PAINTING, Heavy 37 
PAINTING, Water Color 37 
Paper icon 27 
PAPER size 57 
Paragraph defined 15 
Paragraph Indentation 18 
Paragraphs 15 
Paste 12 
Pasted OBJECT 40 
Pasting Text 14 
PATHNAMES 27 
Pictures, Typing over 47 
Pictures, Updating 47 
Print Setup 58 
Print Setup parameters 59 
Printing TEXT ONLY 56 
PRiNTERS (See ImageWriter) 56 
Printing 55 
Printing COLORED OVERLAYS 58 
PRINTiNG QUAliTY 56 
Printing, aborting 59 
Processing Highlighted Text 12 
Prod os (program applications) 27 
Quitting 61 
RE-SIZiNG OBJECTS 39 
REGIONS 41 



REGIONS, Bottomless 41 
REGIONS, Boxed, 41 
REGIONS, CANVAS 43,44 
REGIONS, Creating 42 
REGIONS, Framed 44 
REGIONS, Helpful Rules 44 
REGIONS, Hide 44 
REGIONS, Masking a 48 
REGIONS, OBJECTS within 42 
REGIONS, Selecting 44 
REGIONS, Show 44 
REGIONS, Text within 47-49 
REGIONS, Typing 41 
REGIONS, Unframed 44 
Removing Text 13 
Retrieving Documents 29 
Right MARGIN beyond 8 inches 21 
Rotating OBJECTS 39 
Ruler Settings 15 
Save As Text File 31 
Save As .. 31 
Save Document as .. 52 
Save Window 27 
Saving Documents 26 
Saving to a Folder 28 
Scrapboard 41,44,53 
Scrapboard, Cut or Copy from 44,53 
SCREEN TONES 58 
SCREENING 58 
Scroll Bars 21 
Scroll Thumb 22 
SCROLLING 21,44 
Selecting & Changing an OBJECT 39 
Selecting & Operating on REGIONS 44,51 
Selecting a Color 36 
Selecting Multiple OBJECTS 40 
Setup, Page 56 
Setup, Printing 58 
SHAPE TOOLS 34 
SHAPES 35 
SHIFT-CLICK 12 
Show Full Page 24,51 
Show Regions 44 
SHOW the color 38 
Single and Double Spacing 18 
Size/style of text 12 
Spacing (single/double) 18 

STANDARD Printing 56 
Tab Markers 19-20 
TAB, Center & Decima.1 20 
TAB, Left 19 
TABS, Removing 
TEMPLATES 41,52-53 
TEMPLATES, Creating 52 
TEMPLATES, within FOLDERS 52 
TEXT ONLY file 31 
Text Plus Graphics 47-49 
Text within REGIONS 47-49 
Texf, Copying 14 
Text, Highlighting 12 
Text, Pasting 14 
TEXT, Printing 56 
Text, Removing 13 
TEXT, Save as 31 
Text, Updating 47 
TONES, Screen 58 
TOOLS, Cross 34 
TOOLS, Cross 35 
TOOLS, Drawing 34 
TOOLS, Hand (OBJECTS) 39 
TOOLS, Line 34 
TOOLS, Shape 34 
Typing in Colors 36 
TYPING MODE 34,47 
Typing Over Pictures 47 
Typing REGIONS 41 
Undo 13 
Unframed REGIONS 44 
UP ARROW 21 
Update 47 
WATER COLOR 37,50 
White on Black 43 
Wide ImageWriter 21,57 
Window, FRONT 53 
Word Processing 9 
Word Wrap 17 
Working with Documents 30 



NOTES 


